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Installation

User Interface
WHERE TO DOWNLOAD

HOW TO INSTALL EN ON WIN

HOW TO INSTALL EN ON MAC

CREATE A NEW EN LIBRARY

WIN / MAC LIBRARY SCREEN
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Windows compatibility
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Macintosh compatibility
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Microsoft Word compatibility
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https://endnote.com/product-details/compatibility


How to install EN on Windows
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➊ right-click ➋ select “Extract files…” 
or “Extract Here” 

➌ get a folder

➍ Double-click the .msi 
file to start the EndNote 
installation

DO NOT move/delete the 
License.dat file, or you can only 
use the trial version for 30 days.

EndNote20_Windows.zip

EndNote20_Windows

EndNote20Inst.msi

Please SHUT OFF all word 
processors like Microsoft Office, 
OpenOffice Writer (Even Quick 
Starter function) before you 
installing EndNote .



單位名稱
單位
序號
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Typical : installs ALL features 

and only the most popular 

<500 output styles

Custom：installs EN as you 

like, more than 7000 output 

styles to completely install
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How to install EN on Win
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How to install EN on Mac
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➊ double-click the 
dmg extension file 
downloaded from 
E-Resource System 

➋ double-click the 
central icon

➌ click the Install button 

Close all word 
processors like 
Microsoft Office
before EndNote 
installation.



How to install EN on Mac
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➎ click the Done button to complete the 
installation.

➍ click Next x 2

Typical Installation Type installs 

ALL features and about 500 

output styles
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How to install EN on Mac

Typical Installation Type installs 

ALL features and about 500 

output styles

➎ click the Done button to complete the 
installation.

➍ click Next x 2
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Change Typical to Custom 
installation on Mac

➊Welcome to EndNote 
➋ Select Customizer from 
the EndNote menu

➌ Custom Installation Type
installs EN as you like, about more than 
7000 output styles to completely install

✓
✓
✓



EndNote in Start Menu
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License Agreement
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Create a new EndNote Library
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➊ First time on Windows : choose 
[Create a new library] in the dialogue

Or Select [File] → [New]



Create a new EndNote Library
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➋ choose a storage destination (Desktop is recommended)



How to keep EndNote Library
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Always keep the 

TWO items together

.Data folder

Attachments 

(PDF & other 

file types)

.enl file

Bibliography

Sample 
Library.Data

Sample 
Library.enl

Do not store EndNote 
libraries in iCloud or 

any other cloud-
syncing folder

Keep EndNote libraries 
on your computer's 

local hard drive



Create a new EndNote Library on Mac
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➊ On Mac : Select [File] → [New]

saved your library as a 
package, the .enl file and 
.Data folder are part of 

the library package with 
the extension .enlp

Remember to save Library 
on local hard drive



21.5 on Win & Mac

Update to the latest version

25

Click here to update



Windows Library Screen
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Menus

Search Library

Reference list 

Reference 
Style Preview

Shortcut

Sync
Group

Find full text
Online Search
Group Search

Reference panel 
Preview, edit and 
view PDF

Tab



Macintosh Library Screen
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Menus

Search Library

Reference list 

Reference 
Style Preview

Shortcut

Sync
Group

Find full text
Online Search
Group Search

Reference panel 
Preview, edit and 
view PDF

Tab



It’s YOUR turn!(5mins)

1.Setup EndNote program

2.Create your EndNote library.

3.Make sure you save your EndNote library on computer 

drive (not on online syncing folder)
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Importing Reference Data
ONLINE DATABASE

PDF IMPORT

ONLINE SEARCH

NEW REFERENCE

FIND FULL TEXT

2
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Import from Online Database
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Direct Export
automatically selects an EndNote import filter 

to map bibliographic information into the 

appropriate EndNote fields.

EndNote Filters 
convert the fields in a catalogue or database record into 

a form that can be recognized by the EndNote software.



Web of Science
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Web of Science

32

1
2



Web of Science

33

3

Click to drop down▼
the record content list

4

Select the content you want
(Full record recommended) 

then click [Send]

5 Chrome: click on the ciw file



Google Scholar
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Google Scholar
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1 2
change the setting 

before searching



Google Scholar

36

3

4

5



Google Scholar
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6

7

Single 

reference



Google Scholar
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Multiple 

references

1

Log in Google 

account first!

☆→★

2
Check My library



Google Scholar

39

3.1

or Search in My Library3.2

4

5

Choose or 

create a Label



PubMed
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1



PubMed

41

2

3

4



PubMed
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EBSCO 

Business Source Ultimate
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Work from home



EBSCO 

Business Source Ultimate

44

1 2



EBSCO 

Business Source Ultimate

45

3
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Database Import process
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Field

Export
Download

Citation
Bibliography 

Send to
RIS

ExportCheckSearch



Database Import process
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In EndNote Library [F1] > [Direct Export Formats and Import Formats] > [Output Formats with Corresponding Import 
Options] >corresponding Import Option

Library
Choose 

corresponding option
txt

Filter 
Import

.ris
.enw
.ciw

.nbib

Direct
Import

Import Action in browsersFile typeImport Type



It’s YOUR turn! (10 mins)

1. Go to the databases just demonstrated and find some 

articles.

2. Download bibliographic records (at least 10).

3. Open the downloaded file in EndNote.
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PDF Import
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Scanned / Chinesewith Right DOI*

文

Author
Year
Title

Journal
Volume

Issue
Pages
ISSN

<file name.pdf>

*Digital Object Identifier

CrossRef
PubMed



PDF Import on Win
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1

2

3

4



PDF Import on Win
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3

1

Check the options if you 

have sub-folders and 

want to keep the folder in 

original classification



PDF Import on Mac
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Remember to click on [Options]

Choose the right Import 
Option for the file you 
want to import



Create a new reference
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1

1

2

Select appropriate reference type 
according to the reference 
content, and the fields will 
change with the reference type 
selected

shortcut



Create a new reference
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Enter the information for each field3
First Name Last Name (Max Lin)  

Last Name, First Name (Ke, Nicole)

Group Author, (Cable News Network,,)

When entering group or corporate author 

names, put a comma after the entry.

Alternatively, if your group or corporate author 

name includes a comma in the name itself, 

use ONE commas in place of the first comma.

Press the enter key to go to the next line to 

enter the second author.



Manage & Groups/Tags
FIND FULL TEXT

FIND DUPLICATES

SEARCH

GROUPS/TAGS

3

56



57

All kinds of references
Chinese / No DOI

Western languages 
and with DOI

Attach file Find Full Text

1

2

3

1

2



Find Full Text
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⚫ EndNote can attempt to locate full text files on the Web by using 

data stored in your references up to 250 records at a time. Once 

found, EndNote downloads and attaches the files to the 

references.

⚫ Enter OpenURL Path as Find Full Text preferences, then get the 

subscribed resources your library has paid for.

⚫ Find Full Text Setting Path: 

• Windows: Edit > Preferences > Find Full Text 

• Mac: Endnote 20 > Preferences > Find Full Text 

⚫Outside the Institution: Configure the VPN or Proxy server

first.



Find Full Text
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1

2

3

DO NOT BULK DOWNLOAD 
or the access rights will be 

BLOCKED!

highlight the references you 
want to find full text



It’s YOUR turn!

1. Check for Find Full Text setting 

• Windows: Edit → Preferences → Find Full Text 

• Mac: EndNote [Version] menu→ Preferences → Find Full Text

2. Use “ Find full text “ function (select references → find full text)

3. If PDFs that have not been found, try OpenURL Link.

4. Download the full text file and then attach the file manually.
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Find Duplicates
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1

2

Find Duplicates command searches the 

references that are currently showing in the 

Library window to identify duplicates. 

Duplicates are determined based on the 

duplicate criteria specified in preferences, 

by default are Author, Year, Title and 

Reference Type fields.



Find Duplicates

62

Shows a set of duplicates 
side by side

3

Check or edit the 
record fields and 
decide which one 
to keep and the 
other one will be 
in the Trash



Search
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1

2

Simple Search : 
search terms in all fields

Advanced Search : 
search multiple terms combination by using the Boolean operators AND, OR, and NOT in multiple fields



Groups & Tags
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Group
organize references into subsets within a library, 

functioning like a flexible filing system for 

categorization and retrieval.

Tags

mark individual references with visual indicators 

for purposes like prioritization or action, offering a 

non-hierarchical way to draw attention to specific 

items.



Create a group or a group set
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1

1

Right click to launch 
the function menu 
to create a group or 
a group set



Custom Group
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1
2

Select or Search references
Drag and drop the 
selected references to 
the Group heading

References can be 

removed from any of 

your custom groups 

or online search 

groups and they will 

still be in your library 

and appear under All 

References



Smart Group
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1

2

Smart groups are built with search strategies and 
dynamically updated as you add references to and 
edit references in the library. 

Smart Group 
will be 

updated 
automatically

Set search strategies 



From Groups
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Use AND, OR, and NOT logic to create new, useful 
combined group sets.

Set Boolean logic criteria 1

2

Combination 
Group will be 

updated 
automatically



Display Fields
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Display Fields can be 

customized by yourself

Read/Unread 

Status 
Rating



In the My Tags 
section, right-click to 
present the Tag menu

Create tags

70

Click the + sign in the 
upper right corner to 

quickly enter Create Tag 
to add a new Tag



Manage tags key is 
at the top of each 
document preview

Manage Tags

71

Added New Tag

Tags have been 
added 

Search Tag

Tag is added in 
this reference
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Multiple documents 
are classified into tag 

categories

Select multiple 
documents and drag 
them to a specific tag to 
classify them



It’s YOUR turn! (10 mins)

1. Create a group and drag references to the custom group.

2. Create a Smart Group and edit the search strategies 

3.Create a tag ,darg and drop to the tag

73



Cite While 

You Write
CITE REFERENCES

CHANGE OUTPUT STYLE

CHANGE CITATION FORMATTING

EDIT / DELETE CITATION & BIBLIOGRAPHY

REMOVE FIELD CODES

4

74



Citation & Bibliography
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Citation-Quotation Bibliography-Reference

WHY?
To avoid plagiarism
To help researchers keep track of the 
sources cited for their written material
To give readers a framework of how the 
writers' arguments were formed



Cite While You Write Toolbar

76

Windows Word

Mac Word



Cite References
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➊ place your cursor 
after the text that 
you want to insert 
citation 

➋ go to EndNote 
Library ➌ mark the references you want to insert in 

your article
CTRL key: select discontinuous records
SHIFT key: select continuous records

➍ click the insert citation button 
to insert and go back to WORD



Cite References
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➊ place your cursor 
after the text that 
you want to insert 
citation 

➋ click on EndNote 
ribbon to select 
Insert Citation→

Insert Citation

➌ type in the keyword to find references then 
click to highlight it and insert it

CTRL key: select discontinuous records
SHIFT key: select continuous records



Cite References
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➋ place your cursor 
after the text that 
you want to insert 
citation 

➌ go to EndNote to 
insert citations 

➊ mark the references you want insert
CTRL key: select discontinuous records
SHIFT key: select continuous records



Change Output Style
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1

3

2
select an appropriate 
output style* for your text 
to change citations and 
bibliographies

[Select Another style] 
to more style options 
other than the default 
style list

Annotated

*You can only format a Word 
document in ONE output style.

APA 7th



Change Citation Formatting
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1

place your cursor on the 
citation you want to edit

2

3

4

Add prefix, suffix or 
pages range here 



Edit / Delete 

Citation & Bibliography
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1

place your cursor on 
the citation that you 
want to edit

2

3

4

back to EndNote 
program 
automatically. 
Edit the field you 
want to change and 
save the record

delete highlighted 
citation and 
bibliography

5

refresh the references
if the format remain the same



Remove Field Codes
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Remove field codes before sharing your document 
or send to publisher

Lost codes are never found again!

New copy without EndNote field codes 

CANNOT be reformatted with Cite 

While You Write (CWYW). 

Keep the original document with field 

code for editing by CWYW.

1

2

Windows Mac1



It’s YOUR turn! (10mins)

1.Add citations to Word document by CWYW

2.Edit citation

3.Edit Reference

4.Convert to plain text

 84



Backup & Share

5

85



Library Backup

86

with/without 
attachments

references set

Sample_Library.
enlx

1 2 select export options for library 

3

4 double-click the .enlx 
to decompress the 
library into two parts

Sample_Library.
enl

Sample_Library.
data



Sync
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xxxx@mail.com.tw
One account can be synced 

to One EndNote Library

on One device

EndNote Online on 
iPhone / iPad



Sync Library
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Enter your 
E-mail Address twice

Enter required fields with 
an asterisk below 

Enter registered E-mail 
Address and password

(or WOS account)

Press OK to login

Create a new 
EndNote Account



Sync Status

89

Check detailed 
information of your
EndNote Account



Library on EN online
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Check Library references 
on EndNote Online



Share Library
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Enter Email to invite people

Add an invitation message 
(optional)



Share Library
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Accept invitation 
via the link

Recipient will receive an 
invitation from Email account



Share Library

93



Share Library

94

Accept the invitation to 
access EN library shared by 

others.

Check computer settings to use 
Shared Library



Share Library

95

Revision records



Share Group
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Enter Email to invite people

Add an invitation message 
(optional)



Share Group
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Recipient will receive an 
invitation from Email account

Accept invitation and access 
the group via the link



Share Group

98



Share Group

99

Share permission



Share Group

100

Icon will be changed in 
Shared group



Windows & Mac Function Comparison

101

Function Windows Mac

Preferences Edit Menu EndNote Menu

Check for updates Help Menu EndNote Menu

About EndNote Help Menu EndNote Menu

Customizer No EndNote Menu

Filter Import Import Option Option at bottom left side

Save as package
Mac Only

No
Yes, the package file would be a 
folder containing .enl and .data 

files in Windows OS



Resources & Support
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Resource Notice

EndNote Details
More info about compatibility, integration and 

new functions

EndNote Downloads To download more styles, filters and connections

EndNote Training 

YouTube Channel

Recorded training sections and courses, mostly 

in English

CA EndNote LIVE TRAINING Check the schedule & Time zone and Register

Quick Reference Guide 

(Win,Mac)
Start using EndNote by the instructions

Shou Ray Customer Support
Contact a Support Expert：02-7731-5800

E-mail: services@customer-support.com.tw 

http://endnote.com/product-details
http://endnote.com/downloads
https://www.youtube.com/user/EndNoteTraining
https://www.youtube.com/user/EndNoteTraining
https://clarivate.com/webofsciencegroup/training/?wpv-training-class-product=endnote
https://clarivate.libguides.com/ld.php?content_id=60463276
https://clarivate.libguides.com/ld.php?content_id=60463312


THANKS FOR 

YOUR ATTENTION 
and 

PLEASE DON’T ASK 

TOO MUCH!
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